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Executive Summary

McCrady Training Center (MTC) of the South Carolina Army National Guard hosts seven
confirmed bat species. This project has developed a guide book and performed subsequent data
analysis to monitor these species along with taking a proactive approach in preventing the arrival
and spread of white-nose syndrome (WNS), a deadly fungal disease found only in bats. Since its
2006 discovery in New York, WNS has continued to disperse across much of the eastern United
States and Canada. Research to better understand the WNS fungus, Geomyces destructans, is
ongoing primarily by state and federal agencies. Thus far, only bats roosting or hibernating in
caves or mines, the preferred climate of the fungus, have been affected. WNS was confirmed in
Pickens County, SC in March 2013 joining Georgia as the latest states to show a WNS presence.
Species monitoring involves acoustically recording bat echolocation calls via Anabat SD2
detectors. The calls are displayed on a frequency graph where species identification is
performed. Two methods of acoustical data collection were conducted. The first method
involves driving a predetermined 25 mile route shortly after sunset. This is typically the peak
time for bat activity. The second method entails setting up between one to three detectors
overnight at select sites to record from sunset to sunrise. Several factors can affect these data
collection procedures. The weather, specifically a significant change in temperature, causes a
dramatic shift in activity. For analyzing risk for WNS, there are five abandoned range tunnels at
MTC that mimic the climate of a cave or mine. At least two bat species, Corynorhinus
rafinesquii and Eptesicus fuscus, roost sporadically in these tunnels. C. rafinesquii is listed as
state-endangered in South Carolina. To best monitor the conditions of the tunnels, three
temperature and relative humidity data loggers have been installed in each of the five tunnels.
Preliminary data results are showing average temperatures well within the habitable range of 2 —
10°C for G. destructans. Relative humidity is more fluctuating but still habitable. Future aspects
of this project will continue to develop and change as bat monitoring technology and knowledge
of WNS continue to improve.

Introduction

McCrady Training Center

This project has created and applied a guide book and standard operating procedure (SOP)
for collecting acoustical bat data and other relevant information at McCrady Training Center
(MTC). A 15,000 acre South Carolina Army National Guard (SCARNG) training facility, MTC
is located in Eastover, South Carolina. There are seven confirmed bat species at MTC (46), but
this number is not exhaustive (Bunch et al. 2008). It is likely that migratory species, including
the Hoary bat (Lasiurus cinereus), briefly roost and forage at MTC during their travels. Of
particular concern are the five abandoned range tunnels at MTC. Bats, including the state-
endangered Rafinesque’s big-eared bat (Corynorhinus rafinesquii), roost in these tunnels.

White-nose Syndrome

Bats play a vital role in sustaining a healthy ecosystem. The majority or bats survive on
insects, fruit, or nectar. All bat species in South Carolina are insectivores (Menzel et al. 2003).
A current threat to bats throughout the eastern United States and Canada and the ecosystems they
help maintain is white-nose syndrome (WNS). Fatal to several species of bats, WNS is caused



by the cold-loving fungus Geomyces destructans. It thrives at temperatures between 2 — 10°C,
but it can survive in temperatures as high as 20°C (Foley et al. 2011). There is no known
threshold for relative humidity, but it prefers humid environments. Thus far it has only been
found in caves and old mines. When bats hibernate in these locations, they drop their core body
temperature to their surroundings. If G. destructans is present in the cave or mine, this is when
infection occurs. Most infections are spread bat to bat, but humans can act as carriers of the
fungal spores if clothing and equipment are not decontaminated correctly (Foley et al. 2011).

The fungus was confirmed in South Carolina in a tri-colored bat (Perimyotis subflavus) at
Table Rock State Park, Pickens County. The bat was found dead and showing symptoms of
WNS on February 21, 2013, and lab tests performed the following month confirmed the presence
of G. destructans (SCDNR 2013). WNS earned its name because of the white growth that
occurs on the bat’s muzzle. Growth also commonly occurs on the ears and wings (Meteyer et al.
2009). The disease has killed an estimated 5.7 — 6.7 million bats since its discovery in New
York in 2006 and has diffused in all directions as seen in 15 (Blehert et al. 2009). Some
locations have witnessed the decimation of entire populations of bats (Dzal et al. 2011).
Additionally, bats control the insect population. An individual bat consumes thousands of
insects in a single night. Keeping the insect population under control, particularly in agriculture,
is an ecosystem service valued annually between $54 billion - $1trillion (Kunz et al. 2011). If
bat populations continue to decline, the use of pesticides will increase to combat an increasing
insect population. In turn, this causes increased non-point source runoff and negatively impacts
aquatic environments. Specific to MTC, the abandoned range tunnels are a potential habitat for
WNS and bat infection. This is why strict and continual monitoring of their conditions is
incredibly important.

Anabat Detector & RTR Data Logger

The series of Anabat detectors are among the most commonly used in acoustical bat surveys.
The SD2 is the chosen model for this project (55). Along with recording and saving bat calls, it
is able to divide call frequencies down so they are audible to humans. There are three ways to
collect data with the SD2 including on foot, by vehicle, and placing it in a stationary location to
record overnight (Corben 2011). The latter two methods are being used in this project and are
discussed in more detail in the Data Collection Methods section. The guide book and SOP
(hereafter “SOP”) attached at the end of the document focuses primarily on the setup and
operation of the SD2 and also instructs the user how to analyze the data. Also included under
Data Collection Methods and the SOP are the details for the RTR-503L temperature and
humidity data loggers. Fifteen of these units were installed in the tunnels. They continuously
record, on the hour, the temperature and relative humidity within the five abandoned range
tunnels to see if they are within the habitable range of G. destructans. The stored data is
downloading wirelessly using the RTR-500DC handheld (64). This wireless device allows for
the necessary data to be collected without having to enter the tunnels and risk contaminating or
disturbing the bats roosting within them. The primary contamination concern is G. destructans.

Project Overview

The main purpose of this project is to identify and monitor the bat species and determine
general locations of high and low activity at MTC using the Anabat SD2 acoustical method.



Along with this, the temperature and relative humidity of the abandoned range tunnels are being
monitored. The combination of these two efforts should allow for extensive readiness against a
WNS infestation. For example, G. destructans incubates within its host for approximately 120
days before symptoms begin to appear (Lorch et al. 2011). Once enough data is collected, it can
be determined if, and when, tunnel conditions are appropriate for fungal survival during the
extent of this incubation period. To achieve prolonged monitoring, the SOP has been developed.
This document covers all aspects of the project from equipment setup to data analysis. It has
been designed so that anyone can read through it and participate in the project. This is vital for
the continuation of the project as much of the data collection efforts will be given to future
interns at MTC. The summer months, May — August, are the most important months to collect
acoustic data because this is when the bats are most active (Brooks 2008). MTC always has
summer interns available during these months. Data collection began in June 2012 and has been
performed sparingly since that time. Now that the SOP is nearing completion, data collection
can become much more of a focus. The SOP is considered near completion because it will likely
continue to evolve and change slightly over the next several years. For example, the
construction of four artificial bat roosts at MTC is currently a work in progress.

Vehicle data collection needs to be performed once per month and overnight collection done
every two weeks as weather conditions permit. Weather conditions are a serious limiting factor.
The Anabat SD?2 is easily susceptible to water damage, and bats are not active at night if
conditions are not right for foraging. For example, if the temperature is below 15°C, bats will
not be very active. Additionally, if it is rainy or foggy, bats will be less active as well (Britzke
2003). Data will need to be collected once per month from the RTR-503L tunnel units. Not only
is it important to download the new data, but of possibly greater importance is ensuring that all
units are functioning properly.

Project Goals

The goals have shifted throughout the course of the project, but many of the essential goals
have remained unchanged. The most important goal, as mentioned in the Project Overview, is to
identify and monitor the bat species at MTC using the Anabat SD2, and observe the conditions
of the abandoned range tunnels to determine WNS risk potential through the establishment of the
SOP. Coordinated with these goals is taking the necessary steps to ensure no human actions are
posing a risk to the bats. This is why the tunnel entrances are gated and locked, and if needing to
enter the tunnels, the White-Nose Syndrome Decontamination Protocol is strictly followed.
Prevention methods such as these decrease the risk of WNS exposure and spread. To further
assist with this effort, a total of four artificial bat roosts are being constructed at MTC (66). Two
roosts will be built at each location with one at each site painted black. These black roosts retain
heat better and are often more appealing to bats depending upon the amount of direct sunlight
(Williams et al. 2002). These roosts are being constructed with the help of the South Carolina
Department of Natural Resources (SCDNR). A goal for the near future is to swab the bats
roosting inside the tunnels to certify that there is no current presence of WNS. To perform this,
swabs of the bats need to be taken by an individual vaccinated for rabies. The SCDNR will
likely assist with this as well. These swabs will then be shipped out for testing. The closest lab
capable of WNS testing is in Athens, Georgia. It is hopeful that this can be done during the
summer of 2013.



Data Collection Methods

The data collection methods are covered in extensive detail in the SOP and include step-by-
step instructions. These methods are summarized here.

Vehicle Data

Collecting vehicle data will occur once per month via a Polaris Ranger and will traverse a 25
mile monitoring route (57) at a suggested speed of 20 mph. The starting point is alternated each
time. Collection begins 30 minutes after sunset and includes completing a monitoring datasheet
(57). For this type of monitoring, a PDA is connected to the Anabat SD2, so the recorded calls
can be viewed in real time. This type of monitoring uses an extended microphone that is
mounted to the roof. All recorded calls and extraneous noises are saved to the PDA and upon
completion of the monitoring session, this data is downloaded onto a PC using Windows Mobile
Device Center. Extraneous noises, such as insects, are filtered out during analysis. The PDA has
its own special software called AnaPocket.

Overnight Data

Currently, there are six predetermined sites for overnight data collection (57). The site
number is set at six because MTC possesses three Anabat SD2 detectors, and if overnight
monitoring is performed every two weeks, that guarantees each site being monitored once per
month. Two of these sites occur outside of the abandoned range tunnels because monitoring
them is of utmost importance. The PDA cannot be utilized in overnight monitoring. The
recorded data is saved onto a CF card which has been specifically programmed to be used in
Anabat detectors. Additionally, the CF card is programmed with beginning and end times using
another Anabat specific software, CFCread. Monitoring is always set to begin at sunset and end
at sunrise. By setting the time parameters this way, it ensures that no possible bat call will be
missed.

Protecting the Anabat SD2 against any precipitation or excessive moisture in the air is also
vitally important. The SD2 is not water resistant and can be permanently damaged if it gets wet.
A simple setup using a bucket, rope, Plexiglas, and sponges has been developed to protect the
SD2 (60). The SD2 goes upside down in the bucket along with the sponges which help retain
moisture from getting to the SD2. The bucket is the main source of protection against the
outdoor elements. It gets suspended by the rope to a tree or other stable structure. The Plexiglas
is placed underneath everything at an approximate 45° angle to reflect the bat calls into the
microphone. Come morning, the setup is disassembled, and the data from the CF card is
downloaded onto the PC using the CFCread software. As with vehicle data collection,
extraneous noises are filtered out during analysis.

Tunnel Data

There are three RTR-503L temperature and humidity data loggers within the five abandoned
range tunnels for a total of fifteen. The names they have been assigned are the last two digits of
their respective serial numbers. Data from the loggers can only be downloaded one unit at a time
because the heavy concrete of the tunnels severely impacts the wireless download range of the
RTR-500 DC handheld. Data from the loggers nearest the tunnel entrance can be successfully
downloaded by standing at the respective entrance. It is important that the correct logger is
selected for download or else an error message will appear. Downloading data from the centrally



located loggers involves driving alongside each tunnel until the approximate midpoint is reached.
Once here, the handheld should be in close enough range for a successful download of the data.
Tunnel midpoints have been marked with pink flagging tape to ease this process. One advantage
of this system is the information from the data loggers can be downloaded in any order. Once
the data from all fifteen loggers has been downloaded onto the handheld, the data can be
transferred onto a PC and viewed for analysis.

Data loggers will be installed in each of the four artificial bat roosts once their construction is
complete.

Data Analysis Methods

Like the data collection methods, the data analysis methods are summarized here because
they are covered in broad detail in the SOP. Also included are step-by-step instructions. Data
analysis of recorded bat calls is done through the AnalookW program. It is yet another software
program designed specifically for Anabat detectors. It is within this program that call sonograms
are displayed and analyzed (61). Features of the program include filtering out unwanted calls
and the ability to create identification databases that allow for one-click labeling of species type.
A limitation is that at least five pulses are needed per sonogram call file to ensure call
identification accuracy. Unfortunately, the majority of recorded calls do not meet this five pulse
minimum.

Vehicle Data

Once the initial filtering and identification procedures are performed, there are a variety of
analysis methods that can be done with vehicle collection data. When the PDA is used for
collection, it records a GPS waypoint that is associated with each bat call. In AnalookW, the bat
call files are converted into .gpx files which are further converted for use in ArcGIS and Google
Earth. It is possible to convert the .gpx files into ArcMap shapefiles and display them on the
map of MTC and the vehicle data collection driving route (16). Different ArcMap analysis tools
can then be applied to the data. One such tool is for point density analysis. It is applied to the
data to determine where the highest concentrations of calls are occurring. More basic analysis
methods include a count of recorded calls. As this project continues and more data is collected,
it will be more sensible and appropriate to perform statistical analyses including recorded call
averages and variance. There is currently not enough data for any practical conclusions to be
made. The data is to be imported into an Excel spreadsheet when performing statistical analysis.

Vehicle data collection was conducted on three nights, and the findings from this data are
discussed more under the Results section.

Overnight Data

Overnight collection data is much more limited than vehicle data because it lacks the GPS
element. It is limited to the filtering and identification part covered in the beginning of this
section and statistical analysis via Excel spreadsheets. Like the vehicle monitoring, more data
needs to be collected before any practicable statistical conclusions can be made. A count of
recorded bats calls was executed.



Overnight data collection was performed at varying sites with varying success rates on five
different nights. There were occasions when no calls were recorded. The findings from this data
are discussed more under the Results section.

Tunnel Data

The tunnel temperature and humidity data is downloaded in the RTR-500DC Manager
program once the data is transferred onto the PC from the handheld. From here, there are two
primary ways to analyze the data. First is to open the Temp/Humidity Graph window within the
RTR-500DC Manager. This graphing program displays line graphs of the selected logger data.
A limitation is that it can only display the data for up to four loggers on the same graph. For
more thorough analysis of the complete dataset, the temperature and humidity data for each
logger is exported into two separate Excel spreadsheets. This allows for the appropriate
statistical tests to be performed for each individual logger, each tunnel, or the dataset as a whole.
Statistical tests including determining maximum, minimum, and mean temperatures and relative
humidity were conducted.

Results

Vehicle Data

Vehicle data monitoring was performed on the evenings of June 8%, June 26™, and July 24"
all in the year 2012. There were 42, 59, and 83 bat calls recorded respectively. This averages to
be approximately 61 calls per night. Most of these calls were partial calls and did not meet the
five pulse minimum for identification. However, it can be concluded that at least six bat species
were recorded including big brown (Eptesicus fuscus), eastern red (Lasiurus borealis), evening
(Nycticeius humeralis), tri-colored (Perimyotis subflavus), Brazilian free-tailed (Tadarida
brasiliensis), and Seminole (Lasiurus seminolus). Unfortunately, it is not possible to determine
an estimate of how many of each species was recorded for two reasons. First, the Anabat SD2
cannot record multiple calls at a given time. Every point in time is limited to one call or
recording. Therefore, it is impossible to tell if it is only one bat producing the calls or several of
the same species foraging together. Second, many bat species calls look remarkably similar.
Professionals who have used Anabat detectors for years sometimes struggle with call
identification. For example, the big brown and Brazilian free-tailed sonograms are often quite
similar and cannot be differentiated. However, the rule of thumb is that if both species reside in
the region and several calls of the like exist, then chances are both species are being recorded.

The Rafinesque’s big-eared (Corynorhinus rafinesquii) did not have any documented
recordings because it is considered a whispering bat. This means its call has very low amplitude
(Ford et al. 2006). The Anabat SD2 has a very difficult time picking up this type of call.
However, it has been confirmed that Rafinesque’s big-eared bats currently roost in the
abandoned range tunnels.

The maps displaying the point density analysis results are in 17. Lacking in this data are any
obvious locations of consistent bat activity, but it is hopeful that as data collection continues,
patterns begin to emerge.

Overnight Data



Overnight data monitoring was performed on the nights of August 7™ and August 15" of
2012, and January 29", February 27%, and March 21% 0of2013. Table A provides a breakdown of
the sporadic collection and highly varying results. For analysis sake, the overall average is about
45 calls per site per night. When eliminating the zero values, the average improves to 81 per
night. These values do not hold much merit though because of the varying results in only a
handful of data points. Additionally, varying weather conditions during monitoring must always
be considered because they directly impact the results. There are numerous reasons why the data
resulted in the way it did including microphone failures and as previously mentioned, weather.
For example, the most likely reason why no calls were recorded on March 21 is that the
temperature was not warm enough for substantial, or any, bat activity. The temperature when
monitoring began was 13°C. Monitoring was performed in less than ideal conditions simply to
obtain some data for the month of March. In contrast, on January 29" when 293 calls were
recorded at a single site, the temperature was 20°C when monitoring began and stayed warm
throughout the night. Sites 2 and 6 were excluded for this study due to time and weather
restrictions.

Table A. Overnight Data Collection Site Call Totals

Site 1 Site 3 Site 4 Site 5
8/7/2012 X X X 36
8/15/2012 X 0 27 X
1/29/2013 293 50 X X
2/27/2013 2 X X X
3/21/2013 0 0 X 0

Regarding bat species, the same conclusions can be made for this data as were made for the
vehicle data. The 293 calls recorded at a single site reiterate the fact that Anabat detectors
cannot accurately measure population. Those calls likely came from a small number of bats that
foraged nearby periodically throughout the night. Many of the calls appear to be big brown bats
which also roost in the tunnels. Once again no definitive Rafinesque’s big-eared calls were
recorded. This occurred even with the Anabat SD2 at Site 1 being located right outside a tunnel
entrance with known Rafinesque’s big-eared bats roosting within it.

Tunnel Data

RTR 503L data loggers were installed in the five abandoned range tunnels on February 25,
2013. Three loggers were installed in each tunnel (65). Nine bats were found roosting in the
tunnels during installation. This included four Rafinesque’s big-eared bats and five big browns.
They were programmed to begin monitoring at 8:00 am the following day. Since that time, they
have recorded the temperature and relative humidity of tunnels every hour, on the hour.
Allowing adequate time for data analysis for this project, the final data points were collected on
March 21, 2013 between 10:00 am and 11:00 am. There are 554 hourly data points for each
logger. This means 8,310 points in total.

The maximum, minimum, and mean temperature and relative humidity were calculated both
overall and each individual logger. Tables and graphs displaying these results are in 20. It
should be noted that the temperature data is in degrees Fahrenheit. Additionally, a graph from the
Temp/Humidity Graph window is included. This graph displays the line graphs of the three
loggers in the first abandoned range tunnel. It is clear that there is not much disparity in
temperature or relative humidity throughout the tunnel. Actually, all five tunnels follow the
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same general pattern with only a few exceptions. Even these exceptions were only temporary.
For example, at 5:00 pm on February 26", all fifteen loggers read between 97% — 99% relative
humidity. Shortly thereafter, every the humidity readings for every logger except for E6 began
to decrease. Logger E6 remained at 99% humidity a full 29 hours longer than any other logger
until it began its downward descent eventually settling within range of the others. It is unknown
why and how this occurred but is something worth examining if it continues in the future.
Another logger worthy of mention regarding relative humidity is BD. Its overall average is well
below the others. Once again, it is unknown why this is, but possibilities include its location is
more susceptible to crosswinds, or it could be a faulty sensor. Further exploration is needed.
Excluding logger BD, the range for the averages of the remaining fourteen loggers is only
10.38%.

The temperature data is all around consistent. Its range of averages, including logger BD,
was only 3.31°F. More importantly, the average temperature of every logger, which ranged from
48.16°F to 51.47°F, is well within the habitable range of G. destructans. In fact, only three
loggers, B9, C3, and E2, reached a maximum temperature that is outside the known habitable
range. Their maximum temperatures were 70.34°F, 71.42°F, and 73.94°F respectively.
However, simply reaching these temperatures will not kill the fungus (Blehert et al. 2009).
These temperatures must be maintained. It will be interesting to see if warmer temperatures are
sustained inside the tunnels during the summertime.

Limitations

There were several limitations that developed with this project, and a few of them have
already been briefly mentioned. The most prominent limitations include:

e Unfavorable weather conditions that prohibited Anabat SD2 monitoring and greatly

reduced overall bat activity;

e Difficulty in assigning a single species to recorded calls and the overwhelming number of
partial calls;
Rafinesque’s big-eared bats having a low amplitude call that is near impossible to record;
The Anabat SD2 not being able to provide any real sense of overall bat population;
Lack of a reliable monitoring vehicle throughout portions of the project; and
Occasional Anabat SD2 equipment failures including malfunctioning microphones.

Looking Ahead

The initiation of this project, along with the development of the SOP, will allow MTC to
closely monitor its bat population for years to come. As acoustical technology and knowledge
about WNS improves, this capabilities and success of this project shall grow with it. As
monitoring and data analysis continue, it is a goal that the project area will expand to include
Fort Jackson and additional SCARNG installations. It is promising that as more data is
collected, patterns within the bat activity and abandoned range tunnel conditions will begin to
develop. An example of broadening the scope of the project would be to determine how much of
a relationship there is between tunnel conditions and the ambient weather conditions recorded by
the weather station at MTC.
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As previously mentioned, artificial roosts are currently being constructed, and their constant
monitoring will most definitely be added to this project. The roost locations are shown on the
map in 57 and a picture of a completed roost in 66. These roosts will serve as additional habitat
especially for Rafinesque’s big-eared bats and can be much more effectively monitored than the
tunnels. Another potential project aspect mentioned and currently in development is taking swab
samples of the bats roosting in the tunnels. These swabs will then be sent to lab for testing. The
hope is that the tests are negative, so it can be confirmed that G. destructans has not reached
MTC. Regardless of test result, all current precautions being taken will continue.

Two future project goals that require more development are assessing the environmental
impacts on MTC of a significant bat population decline caused by WNS, and aggregating all the
data into a single database accessible to all employees. The general environmental impacts were
already discussed, but it would beneficial to analyze impacts specific to MTC where herbicides
are already sprayed. Adding insecticides to that is not an action anyone desires to take. Finally,
all current and future data will be assigned to a Microsoft Access database. This is a process that
MTC has newly adapted and is still perfecting. There already exists databases for herpetological
and bird surveys being conducted at MTC. These databases will be used as a guide in
developing an all-access database for this project.
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Appendix A — WNS Map
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Appendix B — Recorded Bat Calls Map
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Appendix C — Point Density Maps
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Appendix D — Tunnel Data Logger Results

Temperature Results {°F)

Relative Humidity Results (%)

Groups | Minimum |Maximum| Average Groups | Minimum | Maximum | Average
BA 34.52 62.6 |48.16523 BA 23 99  61.92419
BB 4064 | 64.4 50.68426 BE 25 99 [57.55776
BC 1236 | 66.02 |19.34986 BC 26 99  |62.58123
BD 39.74 | 63.14 49.02819 BD 15 99  |28.43141
B9 37.76 | 7034 |49.77744 B9 22 99 |56.76354
(& 3092 | 71.42 [50.34928 C3 23 99  |60.35921
Cs 3884 | 66.02 |49.24166 Cs 23 99  |59.80144
ch 31218 | A1.BR 49.07A28 €6 26 99 | 61.2148
7 39.02 | 63.68 [50.65242 7 20 99  |57.14801
EA 42.8 63.5 [50.76516 EA 23 99  |55.93682
E2 4118 | 73.94 [51.47866 ¥ 21 99 | 53.6/87
ES | 3686 | 62.42 49.78556 ES 24 99 [60.31227
E6 38.12 6%  |49.75144 E6 22 99 | 615704
E7 36,14 | 52.29 48.69773 E7 28 99  |A2.6A0AS
E9 3236 | 6638 48.74227 E9 28 99 |A4.06137
Overall | 3092 | 7394 |49.6997 Overall | 15 99 |57.60012

Table B. Temperature and relative humidity data for tunnel data loggers.
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Section 1 — Setup & Preparing to Monitor

This section is broken into three sub-sections. The first sub-section provides directions for
setting up the detector. Each of these steps needs to be completed only once per detector or CF
card. The second sub-section describes the function of the buttons and connectors located on the
exterior of the detector and how to properly insert the CF card. The final sub-section is a list of
system checks to perform prior to monitoring. Make note that some checks should be performed
every time while others only need to be done sparingly.

1.1 Detector Setup

1.1.1 Copy & Download CD Contents

e Files and programs for the Anabat SD2 detector can be found at this path: \MTC-
ENVSRVR4\Conservation\Fish and Wildlife\129 Bat Population Monitoring\Supporting
Documents & Software)\.

e All programs and user manuals are located within the folder entitled “AnaBat CD &
Manual.” This includes the primary user manual entitled “SD2 user manual v1.5.”

e All files and programs can also be found on the CD provided with the detector.

1.1.2 Install USB drivers for Detector and PDA

This process is only done when a COM port needs to be created for the detectors. This port
allows the detectors to operate with the accompanying computer software. To determine if a
COM port exists, along with the number of the port, follow the steps below.

1) Supply power to the detector via 4 AA batteries or a 12 volt battery.

2) Plug the gray USB cable into the detector and computer.

3) Power the detector on if not already done so.

4) Go to Start and click Control Panel.

5) Click on Hardware & Sound.

6) Click on Device Manager. If a warning message appears about being logged on as a
standard user, click OK.

7) Click on the Ports tab.

8) Look for a port named “Anabat SD2 USB VCom Port (COMx)” with x being the port
number. If this port exists, advance to on page 24.

9) Login to an administrative account. PC to USB driver installation can only be performed
logged into an administrative account. If already in an administrative account, ignore this
step.

10) Repeat steps 2 — 6 as needed under the administrative account.

11) Right click where the detector is listed. It will most likely be found under Portable
Devices.

12) Select Update Driver then choose “Browse my computer for driver software.”

13) Insert the Anabat SD2 detector CD into the disc drive or navigate to \MTC-
ENVSRVR4\Conservation\Fish and Wildlife\129 Bat Population Monitoring\Supporting
Documents & Software\AnaBat CD & Manual\, and select the PC to SD2 USB Driver
folder located on the CD as the location to search.

14) When a warning window appears, click “Install this driver software anyway.” After it is
finished installing, a new port called “Anabat SD2 USB VCom Port (COMx)” will
appear under the device manager where x is the assigned port number.
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Because the PDA was ordered directly from Titley Scientific, the makers of the Anabat SD2
detector, all its software is already downloaded and installed. This includes the USB driver.

This process is only done one time for each CF card.

1)

2)

3)

4)
5)

6)

7

Insert the CF card into the drive on the computer. The side of the card with the holes is
inserted first.

If the card does not automatically load, it is because the drive in which the card is
attempting to load is already in use. The first step to change the drive is to login to an
administrator account. If the card does load properly, skip to step 3.

2a) Click Start and then right click on Computer.

2b) Click Manage.

2¢) In the new window, click Disk Management.

2d) Right click on the drive containing the CF card and select “Change Drive Letter and
Paths.”

2e) In the new window, click Change and a final window will open.

2f) Select “Assign the following drive letter” and use the dropdown menu to select a new
drive. The J: drive is typically a good selection.

2g) Click OK to close the window, click OK again to close the next window, and exit out
of the Computer Management window.

Open the CFCread program. Ifno icon is located on the desktop, CFCread can be found
within the AnaBat CD & Manual folder. It can also be found by following the file path
given in on page 23

Once CFCread is open, click Choose Input File.

Locate the drive with the CF card from the drop down menu and click Open. It will be
entitled Compact Flash Drive. The file name will already be set as DATA.DAT. Do not
change the file name.

Click “Initialise CF” and wait several moments for the CF card to be processed. Ifa
warning message appears, accept it because the CF cards are already properly formatted.
A new window will appear when the CF card is finished initializing. Click OK and the
CF card is ready for use in the bat detector.

When the CF card is inserted into the detector, it should enter Record mode (RECORD LED lit
only) or Forced Record mode (RECORD and STATUS LEDs lit) once it is finished booting up if
the CF card was initialized correctly. The specific mode it enters depends upon other parameters
that are set. Table 1 outlines the potential errors that could occur:
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Table 1. Anabat SD2 CF card error messages.

CF Card Errors
LEDs No CF Card Corrupt CF Card
Installed DATA.DAFT) File | Incompatible CF Card Ful

RECORD Off Off Lit Flashing
STANDBY Off Off Lit Flashing
STATUS Lit Off Lit Flashing
ERROR Lit Flashing Flashing Flashing
DATA Off Off Off Off

If the CF card is read as incompatible or corrupt, solutions for these issues can be found on
pages 29 and 81 of the User Manual respectively. Ifthe CF card is full, download and erase the

data using CFCread. Instructions for this are found in on page 41. To avoid this, check the
storage space remaining by holding the RECORD button. Table 2 outlines the CF storage

readings:
Table 2. Anabat SD2 CF card status messages.
CF Status
LEDs < Vi full < full <% full > %4 full
RECORD Off Off Off Flashing
STANDBY Off Off Flashing Flashing
STATUS Off Flashing Flashing Flashing
ERROR Flashing Flashing Flashing Flashing
DATA Off Off Off Off

1.2 Detector Buttons & Connectors Operation

See

1)
3)
4)
)
6)
7)
8)

9

for illustrations of each button and connector.

POWER - Turns the bat detector on and off.

RECORD/STANDBY - Controls operating modes of the bat detector.

VOLUME UP & DOWN — Adjusts the volume hear through the loudspeaker or
headphones.

LEDs ON/OFF — Turns all LED indicator lights on and off except for the ERROR LED.
LEDs: RECORD, STANDBY, STATUS, ERROR, DATA — Indicate the operating
modes of the bat detector and CF card status. See on page 29 for a further explanation of
operating modes.

DATA DIV: 16, 8, 4 — Press to select data division ratio indicated by LEDs. See on page
27 for a further explanation of data divisions.

AUDIO DIV: 32, 16, 8 — Press to select audio division ratio indicated by LEDs. See 27
for a further explanation of audio divisions.

MIC. — Press to record audio or voice comments. All other bat detector functions will be
suppressed while comments are recorded. The CF must be installed to record comments.
SAVE — Press to manually save detected bat calls. It can also produce a 40 kHz
calibration tone when not monitoring.
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10) LOW BATTERY - Indicates internal or external battery power is low.
11) SENSITIVITY Control — Adjusts the sensitivity of the microphone to detect bat calls.

Rotate clockwise to increase sensitivity and vice versa.

12) AUDIO MIC - Used to detect audio or voice comments when the MIC. button is

pressed.

13) SPEAKER — Emits sounds captured by microphone after going through audio division.

1)
2)
3)
4)

)
6)

HEADPHONES - Insert headphones into jack to listen to bat calls using headphones
rather than the loudspeaker.

COMPUTER SERIAL PORT - This port is used to connect the bat detector to a PC or
PDA using the cable supplied by Titley Scientific.

USB — This port is also used to connect the bat detector to a PC or PDA. It cannot be
used as a host for external hard drives or USB thumb drives.

HF OUTPUT - This port is used to connect the detector to an external high-speed A/D
card and separate storage device, such as a laptop, to process and save full-spectrum
signals. See page 19 in the User Manual for further explanation.

+12 VOLTS — An external 12 Volt battery can be connected to power the SD2.
DIGITAL I/0 — Digital I/O port is used to connect external equipment such as a weather
station to the detector, and is configured to switch the SD2 on or off remotely. See page
20 in the User Manual for further explanation.

Refer to the User Manual for further explanations of all connector functions.

NEVER INSERT OR EJECT THE CF CARD FROM THE DETECTOR WHEN IT IS
TURNED ON UNLESS NOTED IN THE USER MANUAL OTHERWISE!

COMPACT FLASH (CF) CARD ACCESS Panel

1)

2)
3)
4)

Unscrew the two screws attached to the panel cover. The screws will remain attached to
the cover, leaving no risk to losing them.

Insert the CF card face up with the side containing the holes going in first.

Once inserted, reattach the cover.

To eject the CF card, press the black button to the left of the card.

1.3 System Checks Prior to Monitoring

Everything in these sub-sections is to be performed in the office.

Use the green “high energy” microphone while monitoring from a vehicle. It is designed
to be used in situations where the microphone is not directly mounted to the detector.
Use the black “low energy” microphone in all other situations. It is the standard
microphone.

The detector requires either 4 AA batteries or a +12 volt battery.
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If using AA battery power, be sure to insert new batteries before each sampling session
especially if monitoring overnight.

The +12 volt battery plug is located on the side of the detector.

Every time the detector is turned on with a CF card installed, a new file is created on the card.
These files keep a log of everything done while the detector was on. This includes buttons
pressed, operating modes, and any errors that may have occurred. To access the log information:

1)
2)

3)

Power off the detector and remove the CF card.

Insert it into the PC and open the card files. Inside the log folder is where the log files
are automatically stored.

This folder can hold up to 99 files (log99.txt). Once that limit is reached, the older files
will be overwritten starting with log01.txt. Therefore, the highest numbered file may not
be the newest. The syslog.txt folder will give the name of the file it plans to create next
which helps to identify the newest file. For example, if the next file to be created is
log05.txt, then the newest file should be log04.txt.

Checking for CF card storage is explained in on page 24.

1)

Data division ratios record data points in the resulting sonograms for the purpose of Zero-
Crossings Analysis. Data division ratio options are 4, 8, and 16. The lower the division
number, the more points recorded and storage required.

Press the DATA DIV button to toggle between ratios.

The recommended ratio is 8 because it of its effectiveness in analyzing short duration
calls and “whispering” bats such as the Rafinesque’s big eared.

If using the PDA, make sure the data divisions set on the detector and PDA match. For
directions on how to change the setting on the PDA refer to on page 31.

A data division of 16 can be used if lack of storage space is an issue because it requires
the least amount of space.

Audio division ratios take the frequencies recorded above the range of human hearing
and divide them by the selected ratio. This makes them audible to human ears through
the speaker. Audio division ratio options are 8, 16, and 32.

Press the AUDIO DIV button to toggle between ratios.

The recommended ratio is 16. Therefore if a 40 kHz bat call is recorded with the
setting at 16, a 2.5 kHz tone will be heard through the speaker. Pressing the Save button
while in Forced Command mode will produce a 40 kHz signal. This can be used as a
reference to compare and learn how different bats produce different sounding
frequencies.

Make sure no CF card is installed in the detector and power it on.
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2)
3)
4)

The detector should be in Command mode with the STATUS and ERROR LED:s lit.
Adjust the sensitivity to 5 and the volume up or down as necessary.

Rub fingers together above microphone. If the detector is working correctly, sound
should be produced out of the speaker.

1.3.8 Checking Firmware

1)
2)
3)

4)
)

Connect the detector to the PC via the USB port cable. Make sure no CF card is
installed.

Turn the detector on and open the CFCread program.

Select the port that is in use by the detector. This information can be found under the
Device Manager. For directions on how to access the Device Manager, see on page 23
steps 4 — 8.

After determining the correct port number and having it selected, click the Open icon.
In the new window, click the Version icon to see the firmware version currently being
used.

Checking firmware needs to be performed only bi-annually.

1.3.9 Upgrading Firmware

1)

2)
3)

4)
5)

6)

Copy and paste the firmware.hax file onto a CF card that has been inserted into the PC.
The path for the file is: \MTC-ENVSRVR4\Conservation\Fish and Wildlife\129 Bat
Population Monitoring\Supporting Documents & Software\AnaBat CD & Manual\.
From here navigate to SD2 Firmware = SD2 NOT connected to a GML - v4055g.
Remove the CF card from the PC and insert it into the detector.

Before powering on the detector, hold down the SAVE button and keep it held down. If
this is not done, the firmware file will not be recognized.

With the SAVE button pressed, turn on the detector.

Once the Boot mode LEDs flash and a beep is emitted from the detector, the SAVE
button can be released. This begins the firmware upgrade.

Table 3 displays how the LEDs are used to show the upgrade progress:

Table 3. Updating Anabat SD2 firmware LED indicators.

Firmware upgrade progress as indicated by the LEDs
LEDs Progress at each stage

« AUDIO DIV 32  Baftery voltfage is OK

« AUDIODIV 14 The firmware. hax file has been found

« AUDIO DIV S The firmware.hax file is valid and uncomupted

« DATA DIV 16 The existing firmware is being erased

« DATA DIV E The new firmware is being programmed

« DATA DIV 4 The new fimware has successiully been programmed

When the upgrade is installed successfully, a distinct four tone sound will be heard from the
detector and it will reboot. Ifthe upgrade is unsuccessful and a low pitch is heard, one of the
steps in the upgrade failed. The detector will reboot and continue to run normally. If ALL the
LEDs start flashing, one of the steps failed after the old firmware was erased. Do not power off.
Eject the CF card, insert it into the PC, and make sure the firmware.hax file is not corrupt. In
both situations of an unsuccessful install, check the latest log file within the log folder on the CF
card and look for any issues to be described there.
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Upgrading firmware needs to be performed only bi-annually.

1) Remove the CF card if inside the detector.

2) Power on the detector and connect it to the PC via the USB port.

3) Open the CFCread program and select the port connected to the detector. Refer to on
page 23 for directions on how to determine which port number the detector is using.

4) Click Open and then click Check in the bottom right of the window to check the date.
The time difference between PC and the detector will be given under Status.

5) Ifnecessary, to change the time of the Anabat so it matches the PC, click Set. It should
then read “ZCAIM Time Set OK” under Status.

Setting the time on the Anabat clock needs to be performed at least bi-annually during
daylight savings time.

Section 2 — Operations

This section provides an overview of all the operating modes of Anabat SD2 detector. Each
mode is briefly described, and a summary table is included at the end of the section.

2.1 Operations Overview
Use the RECORD/STANDBY button to toggle between modes.

Boot Mode: The detector is starting up. Time to complete varies by how much data is stored on
the CF card.

Command Mode: Automatic mode upon startup when no CF card is installed. This mode
allows for the adjusting and changing of settings through AnaPocket (PDA) or AnalookW
(computer). Bat calls are audible through the loudspeaker but are not saved.

Forced Command Mode: Occurs when a CF card is installed and the RECORD/STANDBY
button is pressed upon startup and allows for settings to be adjusted or checked within CFCread.
Switching to this mode from Sleep or Standby allows for setting and sensitivity changes to be
made on the detector. Like Command mode, calls are audible through the loudspeaker but are
not saved.

Record Mode: Accessed in two different ways: 1) When using a PDA or computer during active
monitoring and they are in Record or Monitor mode. Calls are not automatically saved unless
AnaPocket is in Monitor mode. 2) When passive monitoring and time parameters are set, the
detector will be in Record mode between the determined begin and end times. Calls are
automatically saved onto the CF card.

Forced Record Mode: The detector is in this mode automatically upon startup when a CF card

is installed and no time parameters have been set. Bat calls are saved onto the CF card and the
DATA light will flash when a potential call is detected.
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Sleep Mode: Occurs when a CF card is installed and is programmed for a Delayed Start with
specific time and date parameters set. The detector will then be in Forced Record mode until
switched off. Sleep mode is indicated by the LEDs for 10 seconds before becoming inactive.
Standby Mode: Occurs when a CF card is installed and programmed with Monitoring Begin and
End time parameters. The detector will be in Forced Record mode between the set beginning
and end times and will return to Standby mode once the recording session has ended. Standby
mode is indicated by the LEDs for 10 seconds before becoming inactive.

Table 4 provides a breakdown of which LED lights are lit or flashing with each operating mode:

Table 4. Updating Anabat SD2 operating mode LED indicators.

A SUMMARY OF OPERATING MODES INDICATED BY LEDS

Mode
LEDs Forced Forced
Boot | Command Command Record Record Sleep | Standby
RECORD Lit Off Off Lit Lit Lit Off
STANDBY Lit Off Off Off Off Lit Lit
STATUS Lit Lit Lit Off Lit Off Off
ERROR Off Lit Off Off Off Off Off
May May
DATA Off Off Off Flash* Flash* Off Off

* will also flash when valid GPS fixes are received if SD2 is connected to a GPS unit.

Section 3 — Monitoring Types & Setup

This section details the monitoring types and how to set them up to begin monitoring. All steps
that need to be taken prior to the actual monitoring are covered for both vehicle and overnight.
The final part of this section provides instructions for the setup and installation of the
temperature and humidity data loggers mounted in the old range tunnels. The decontamination
process prior to entering the tunnels is included in this section. Finally, it should be noted that
the weather conditions are the most significant determining factor on whether monitoring
can occur on a given day. Bats are much less active on nights when it is foggy or raining,
windy, or the temperature drops below approximately 60°F. Additionally, Anabat SD2
detectors are not waterproof. Exposure to rain or excessive humidity can damage them
beyond repair. In high humidity, the detector’s range for recording calls is also restricted.
Therefore, they must only be used in dry conditions and be stored in a protective container when
monitoring overnight. Finally, weather conditions on sampling nights should be as similar to
each other as feasibly possible. This consistency is important in being able to compare data
collected on different nights. Following the weather related parameters given above is a good
place to start.

Perform these procedures within an hour of heading into the field.
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3.1 Vehicle Monitoring

This monitoring method is effective when needing to cover large distances in a fairly short
amount of time. Monitoring can be performed from either truck or UTV with the latter being the
preferred method. A map of the 25 mile monitoring route can be found in . The file
path is located at the bottom of the map. Data needs to be collected from this route once per
month alternating starting points each time.

1)

2)
3)
4)

)
6)

7)
8)

If using a CF card to save data, insert it now. If using a PDA, skip to Section 3.1.2 and
complete steps 1 - 5 before moving on to step 2 in this section.

Attach the green microphone to the roof mount if not already attached.

Remove the red base cover.

Make sure the roof surface is clean, and attach the roof mount to the passenger side roof
of the vehicle by repeatedly pressing the white plunger until the red line is no longer
visible.

Point the microphone straight up towards the sky.

Make sure the detector is off and connect the roof mount cable to the microphone
socket on the detector. Remove the black microphone from detector if needed.

Power the detector on.

Adjust detector settings (Sensitivity, Volume) as needed. The recommended sensitivity
level is 6 but can be lowered slightly if too much excess noise is being recorded.

It shall be noted that the PDA (HP iPAQ hx2490c¢) has been setup by Titley Scientific, so this
section focuses solely on its use in monitoring. Using the stylus included with the PDA during
operation is highly recommended. Be sure to charge the PDA battery AT LEAST three
hours before monitoring is set to begin to give it enough time to charge.

1)
2)

3)
4)

)
6)
7)
8)

9

Remove the CF card if one is installed in the detector.

Attach the PDA bracket to the detector via the screw openings located on the side of the
detector (screws included and look similar to those attached to CF card cover).

Connect the PDA to the detector via the SERIAL port to USB port cable.

Turn on PDA and make sure date and time are correct. If not, tap the date and time on
the main screen to change it.

Adjust the backlight level as needed using the light bulb icon on the main screen.
Complete steps 2 — 8 in Section 3.1.1 before continuing on to the next step.

Open AnaPocket by either clicking Start > AnaPocket or by pressing the right most
button on the PDA (the button with an arrow on it).

Make sure the division ratio set in AnaPocket matches the setting of the Anabat detector.
To check the division ratio in AnaPocket tap Opts - Record.

With AnaPocket still open, Tap Rec > “Choose port” to determine which port was used
the last time the PDA and detector were connected. If a port number is given, tap “Try
this port.” If this does not work, or it is the first time the PDA and detector have been
connected, tap “Search ports.” This will find a useable port for connecting the two pieces
of equipment. Tap Close to return to the main AnaPocket screen.

10) If wishing to have bat call files saved automatically make sure the “Save on Cal” option

is not checked. This option is located under Opts - Record.
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11) If wishing to save bat call files manually after examining them on the AnaPocket screen,
make sure the “Save on Cal” option is checked.

12) Check that the time frequencies are correct. Tap Time on the bottom of the AnaPocket
main screen and make sure “Comp” and “Dpp4” are both checked.

This can only be performed after all steps in Section 3.1.2 are completed.

1) Insert the CF GPS card into the slot atop the PDA.

2) Check that the baud rate is set at 4800 and that the appropriate time zone is selected (-4
for South Carolina) by tapping GPS - Settings in AnaPocket.

3) In the same window, select COM6: from the Port List and tap OK.

4) Tap GPS > Connect. The GPS map should display with a red square tracking the current
location. North is always the top part of the screen. The PDA has a tendency to freeze
during this step. If it does, press the reset button on the bottom of the PDA and try again.

5) Synchronize the PDA clock with the GPS by tapping GPS - Set Clock.

6) Tapping around the middle of the PDA screen will cause it to switch between the GPS
map and the main AnaPocket screen.

If a datasheet is needed, either print it from or from this path: \MTC-
ENVSRVR4\Conservation\Fish and Wildlife\129 Bat Population Monitoring\Data\Data
Collection Sheets\. The file is entitled “Acoustic Monitoring Datasheet.” The following is a
breakdown of how to complete the datasheet:

Investigator(s): List everyone involved in monitoring for given night.
Date: Day the monitoring occurred.
Monitoring Type: Check either “Vehicle” or “Overnight.”

Monitoring Number: Follows in sequence of last number for each monitoring type. If vehicle
monitoring, the number should include “V” for vehicle monitoring and an “E” for east or “W”
for west to denote starting point (ex. 2VE). If overnight monitoring, the number should include
“N” for overnight monitoring (ex. 2N).

Anabat Number(s): Assigned number (e.g. ANABAT 1) of detector(s) being used. Both the
detector and box are labeled.

Start Lat/Long: Latitude and longitude of the starting point when performing vehicle
monitoring or the location where the detector is placed for overnight monitoring. Give the
location(s) in decimal degrees. The coordinate points can be found at the top of the GPS map
in AnaPocket on the PDA.

End Lat/Long: Latitude and longitude of the ending point when performing vehicle monitoring.
Give the location in decimal degrees.
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Start Survey: Parameters that need to be completed before monitoring begins. Information can
be found at various locations including the WeatherBug application in Google Chrome,
www.weather.com, or www.wunderground.com. All parameters, with the exception of Time,
may be completed immediately prior to leaving the office. Time is recorded right at the starting
point. Ifneeding to access past weather data, navigate to the Pilgrim Church Weather Station at
this path: \MTC-ENVSRVR4\Conservation\Weather Station\Pilgrim Church\.

End Survey: Parameters that need to be completed after monitoring ends. All parameters, with
the exception of Time, must be completed immediately after returning to the office. Time is
recorded right at the end point.

Time: The time the monitoring begins and ends. This should be recorded right at the start and
end points.

Temp (F): The temperature in Fahrenheit at the beginning and end of monitoring.
Humidity: The percent humidity at the beginning and end of monitoring.

Wind Speed: The wind speed in miles per hour and direction at the beginning and end of
monitoring.

Cloud Cover: The amount of cloud cover in the sky at the beginning and end of monitoring.
Should be described as either clear, few, partly, mostly, overcast or something of the like.

Moon Visible?: Whether or not the moon is visible in the sky at the beginning and end of
monitoring. A very helpful moon rise and set chart to assist in this determination can be found at
http://aa.usno.navy.mil/data/docs/RS OneYear.php. Complete Form A and click Compute
Table. Rise and set information can also be found at http://www.almanac.com/moon.

Moon Phase %: Percent of moon “visible” for current phase. Should be noted regardless of
whether moon is actually visible and only needs to be recorded during start of survey. Several
websites provide this information including http://www.almanac.com/moon and
http://www.calendar-365.com/moon/moon-calendar.html.

Comments: Record anything of significance to the monitoring process including excess noise
picked up by the detector, poor road conditions, making a wrong turn, equipment malfunction, or
taking a break in sampling.

~

3.1.5 Parameters to Obey when Monitoring from a Vehicle

e Begin monitoring 30 minutes after sunset.

e Driving speed is 20 mph when possible.

e Monitoring should only be conducted on nights that are suitable for bat activity (low
wind, no rain/fog, temperatures near 60°F or higher).

e Ifcompleting multiple routes with the same detector in the same night, be sure power the
detector off then back on before beginning a new route. This will ensure a separate log
file being created for each individual route.
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e If completing multiple routes with the same detector in the same night, complete a
separate datasheet for each route.

e If needing to stop, slow down for an extended period of time, deviate from the mapped
route during monitoring, etc. make sure it is noted on the datasheet.

Anabat SD2 Bat Detector

Roof Mount

Route Map

2 CF Cards (if not using PDA)

PDA and CF Card (important to have CF card at all times in the event of a PDA
malfunction)

PDA Bracket

GPS Attachment to PDA

Datasheet (see Appendix I1I)

Pen

Extra AA Batteries

Flashlight and Headlamps

Orange Vests

Communications Radio

Small Flathead Screwdriver for USB Cable

N I I oy

N Y Y O B o O

Checklist can also be found in for printing.

3.2 Overnight Monitoring

This monitoring method is effective when needing to monitor a particular area for an extended
period of time, typically a full night. For this monitoring method, the detector should be placed
in a protective bucket with only the microphone exposed to help protect it from the elements.
The bucket is attached a tree or pole along with a reflective plank, so the bat calls can bounce off
the plank and be received by the microphone. This process allows the detector to be safely
protected while minimally affecting the bat call receiving quality and accuracy. More
information regarding protecting the detectors is given in 39. A map of numbering the six
monitoring sites can be found in 57. The file path is located at the bottom of the map. Data
needs to be collected from the six monitoring points (e.g. range tunnels) once per month.
Three overnight monitoring sessions of two points each is the suggested rate for each
month.

1) Insert a CF card into computer.

2) Open the CFCread program.

3) Click on Choose Input File and select the CF card drive.

4) Select the DATA.DAT file and click Open.

5) Check Activate (the one located above the “Initialise CF” button) and enter the date and
time monitoring shall begin. The month is changed by typing the corresponding number
of the desired on the keyboard. For example, typing “3” will change the month to March.
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6)

7

1)
2)

3)

4)

Click Erase. Any previous data stored on the CF card will be erased. Make sure it
has been downloaded and saved elsewhere first.
Click Quit.

Complete steps 1 — 4 from Section 3.2.1.

Check Activate and enter the times for monitoring to begin and end. Monitoring should
be set to last from sunset to sunrise. Refer to www.weather.com or
www.wunderground.com to determine these times.

Click Erase. This sets the times given on the CF card. Any previous data stored on the
CF card will be erased. Make sure it has been downloaded and saved elsewhere first.
Click Quit.

If powering off the detector at any time while completing these steps or once the detector
has entered Standby mode, make sure to power detector back on and that the STANDBY
LED is lit. The LED will shut off after 10 seconds, and the detector will remain dormant until
the designated recording start time.

1)
2)

3)

4)

5)

6)

Install 4 new AA batteries into each detector before each monitoring session.

Insert the CF card with programmed time parameters into the detector if one is not
already installed.

Power the detector on. Ifit is outside the programmed recording period, the detector will
enter Standby mode after 10 seconds.

If changes need to be made to the detector’s settings (data division ratio, sensitivity),
press the RECORD/STANDBY button once and make the needed adjustments.
Sensitivity level should be set to 6.

Press the RECORD/STANDBY button twice to put the detector back into Standby mode.
If using Delayed Start, the RECORD and STANDBY LEDs should be lit. If using
Begin/End times, only the STANDBY LED should be lit.

To later check the operating status, press the LEDs ON/OFF button. If the detector is
recording, the RECORD button will light. Doing anything beyond this could disrupt the
recording session. If the detector is still in Standby mode, none of the LEDs will be lit.
If still in Standby mode, it is safe to power on the detector and make any needed changes
as described in steps 3 and 4.

Follow the numbered instructions given in on page 32. Ignore the sentence referring to Section

3.1.2.

Refer to on page 32 for directions on completing the datasheet while noting the additional
instructions given below:

Now is the time to determine which sections need to be monitored for this particular
session.

Include in parentheses, next to its respective number, the site number where each detector
is located.
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Make sure to write each separate GPS point clearly between the dividers within the “Start
Lat/Long” section.

The “End Lat/ Long” section does not need to be completed.

Only the “Time” parameter needs to be completed under “End Survey” but other
parameters may be completed if accurate data is available for the end time.

The detectors need to be placed somewhere near the points on the map or outside a range
tunnel entrance.

.6 Overnight Monitoring Items Checklist

Anabat SD2 Bat Detector for Each Site Being Monitored (max of 3)
Bucket with Lid for Each Detector (bucket should have hole in bottom)
Sponges

Reflector Plank for Each Detector

Rope (use pre-cut pieces first)

Knife or Scissors to Cut Rope (if necessary)

Map of Monitoring Sites

One CF Card for Each Detector Being Used

PDA with GPS Card Attached

Datasheet (see Appendix III)

Pen

Flashlight and Headlamps (depending on time of day placing/retrieving detectors)
Orange Vests

Communications Radio

DO NOT DISTURB sign and tape if needed

Zip Ties (only for hanging on tunnel gate)

Checklist can also be found in 56 for printing.

3.3 Range Tunnel Temperature/Humidity Monitoring

3.3.1 Decontamination

If entering the tunnels, the National WNS Decontamination Protocol must be followed. Be sure
to review it as needed. Equipment utilized to prevent contamination includes:

Tyvek Suits

Surgical Masks
Latex/Rubber Gloves
Disinfectant Wipes
Garbage Bags

Upon entering a tunnel, put on a Tyvek suit, surgical mask, and gloves.

Upon exiting a tunnel, remove all protective clothing and dispose of it in the garbage bag.
Wipe down all equipment taken into the tunnel with the disinfectant wipes.

Repeat this process for each tunnel.

Once finished, wipe down all equipment one final time and dispose of the garbage bag.
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3.3.2 Data Collector Software Installation

These steps only need to be performed if the software is not installed onto the computer.
The software applications will not open properly if not installed directly to the computer.
Installation must be performed from an administrative account. Skip ahead to Section 3.3.3 if
installation has already been performed. A diagram listing all the parts of the RTR-500DC is
located in on page 64 (Figure 17). User manuals are located at the path provided below.

1)

2)
3)

If needing to install the RTR-500DC to the desktop, go to this path: \MTC-
ENVSRVR4\Conservation\Fish and Wildlife\129 Bat Population Monitoring\Supporting
Documents & Software\RTR-500DC Materials\Software Installation Files\.

Click on the Start file and in the new window, click Execute.

Follow the prompts as needed to finish the installation. Once complete, the applications
will be available in the Windows Start menu.

3.3.3 Data Collector Setup

Check if the USB device driver is installed. Follow steps 2 — 8 in on page 23 to determine if
the driver is installed. The port will be called “TandD General UsbUart Port.” If already
installed, setup is complete. If needing installation, follow the steps below.

1)
2)
3)
4)
5)
6)

7

8)
9)

Login to an administrative account. PC to USB driver installation can only be performed
logged into an administrative account. If already in an administrative account, ignore this
step.

Repeat steps 2 — 6 in on page 23 as needed under the administrative account.

Right click where the detector is listed. It will most likely be found under the “Other
devices” tab.

Select Update Driver then choose “Browse my computer for driver software.”

Navigate to \MTC-ENVSRVR4\Conservation\Fish and Wildlife\129 Bat Population
Monitoring\Supporting Documents & Software\RTR-500DC Materials\ and select the
Driver RTR-500 folder.

If a new window appears, click Install. After it is finished installing, a new port called
“TandD General UsbUart Port (COMx)” will appear under the device manager where X is
the assigned port number.

Open the RTR500DC Manager. If there is not a shortcut for it on the desktop, use the
link in step 5 to access and open the RTR500DC application. Another option is to access
it through the Start menu.

Click Settings > Remote Unit Registration.

Select Base Unit Settings in the left panel.

10) Set °F as the Unit of Temperature, select “Set Time to Computer Clock™ under Current

Time, and set Time Zone to be (UTC-5:00).

11) Click Apply.

3.3.4 Remote Unit Registration

The User Manual for the remote units is located at this path \MTC-
ENVSRVR4\Conservation\Fish and Wildlife\129 Bat Population Monitoring\Supporting

Documents & Software\RTR-500DC Materials\Software Installation Files\. A diagram listing

the parts of the RTR-503 is located in on page 64 (Figure 18).
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If necessary, assemble the large capacity battery pack (RTR-500B1) and attach them to
the remote unit(s). Follow the directions provided in the RTR-500B1 User’s Manual that
is found within the folder linked above and called “rtr-500B1-usermanual.”

Plug the gray USB cable into the data collector and computer.

Power the RTR-500DC on if it does not turn on automatically.

Open the RTR500DC Manager. Click Settings > Remote Unit Registration.

Select Remote Unit Settings in the left panel.

Click Register and click “Yes” when asked “Do you wish to register this Remote Unit?”
Connect the data logger and remote unit to each other as prompted by the directions on
screen.

Assign the remote unit to McCrady for Group Name.

The Remote Unit Name for each remote unit is determined by the last two characters of
its serial number (SN). For example, if a remote unit has an SN of 32BC02BB, its
Remote Unit Name is BB. The Remote Unit Number is predetermined by the program.

10) Communication Frequency Channel, Ch.1 and Ch.2 should be preset as 1, Temperature,

and Humidity respectively. If not, make sure the Group Name is correct.

11) Set Recording Mode to Endless.

12) Set Recording Interval to 60 min.

13) Set Warning Monitoring to OFF.

14) The registration information should look similar to Table 5. Once everything is correct,

click Register.

15) Repeat steps 7 — 15 for each additional remote unit.

Table 5. Example of remote unit information.

Serial Mumber 32BC02BB
Group Mame McCrady
Remuote Unit Mame BB

Remote Unit Mumber 2

Communication Frequen... 1

Chl Temperature
Ch.2 Humidity
Recording Mode Endless
Recording Interval 60 min.
Warning Monitoring OFF

Section 4 — Monitoring Procedures (in the act of monitoring)

This section describes the process and procedures to remember while monitoring is in progress.
It covers both vehicle and overnight monitoring. Also included are the steps to collect data from
the temperature/humidity data loggers. Most turns on the vehicle monitoring route are
marked with pink and yellow reflective tape.

4.1 Vehicle Monitoring
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1) Drive to the starting point and finish completing the “Start” sections of the datasheet.
This includes recording the Lat/Long reading on the GPS map (if using the PDA) and the
time. If not using the PDA, skip final two steps and begin monitoring.

2) Tap GPS > New File to create a new GPS map so only the driving route is included.

3) Begin monitoring.

4) Remove the batteries from the detector when finished monitoring.

e Obey parameters listed in on page 33.

e Take notes under the Comments section as deemed necessary.

e Keep the headlamps and flashlight nearby. They will be needed to read the map once it is
dark.

e Slow down if necessary for safety reasons. Driving 20 mph is only the suggested speed.

¢ Avoid low hanging branches when possible to protect the roof mount from being
damaged or coming dislodged.

e Do not let the extra cable connecting the roof mount to the detector dangle outside of the
UTV. It can easily become caught on a low hanging branch.

e Several turns along the route are marked with yellow and pink florescent reflective tape
to assist in navigation.

If using the PDA:

e C(Closely view the PDA screen as monitoring is in progress to make sure too much insect
and road noise is not being recorded by the detector. Lower the sensitivity from its
suggested level of 6 if necessary to correct this problem. However, the sensitivity
should never drop below 5.

e Ifneeding to stop or backtrack, suspend the monitoring session by tapping STOP on the
PDA. When ready to resume, tap Rec > Monitor if automatically saving bat calls or Rec
- Record if manually saving calls.

If using the CF card:

e Carefully listen to the detector to determine if it is recording too much road noise. Lower
the sensitivity from its suggested level of 6 if necessary to correct this problem.
However, the sensitivity should never drop below 5.

e Ifneeding to stop or backtrack, suspend the monitoring session by simply turning the
detector off. When ready to resume, turn the detector back on. This will create a new log
file on the CF card. It is vital to make note of this for when it comes time to download
the data onto the computer.

4.2 Overnight Monitoring

Reference pictures for setting up protective equipment as described in the following steps can be
found in 60 (Figures 4 — 6). It is suggested that two people assist each other in the setup of the
protective equipment.
1) Upon arrival to the monitoring site, select a tree (or gate if monitoring outside of tunnels)
that is appropriate for hanging the bucket and Plexiglas plank. The tree should have a
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branch that the bucket handle can hang from with the bottom of the bucket hanging at
least 4 feet from the ground. If hanging from a gate, hang handle from the top bar
preferably using zip ties.

2) Ifa DO NOT DISTURRB sign is not on the bucket, attach one now. If a new sign needs to
be printed and laminated, it is located at this path: \MTC-
ENVSRVR4\Conservation\Fish and Wildlife\129 Bat Population Monitoring\Data\Data
Collection Sheets\. With the detector OFF, remove the microphone from the detector.

3) Safely secure the detector within the bucket using approximately 10 — 12 of the 6 x 3.6 x
1.5 inch sponges. Make sure none of the buttons are accidentally being pressed from the
pressure of the sponges.

4) Reattach the microphone through the bottom of the bucket.

5) Power the detector on, make sure it enters Standby mode, and close the lid.

6) Wrap and tie rope around the bucket and tree (pole) to provide extra stability.

7) Take another piece of rope to loop through one end of the Plexiglas. Loop it by going
down through the first hole on the side labeled “UP” and back through the other hole.
This will ensure the loop created by doing this will be on the underside of the plank.

8) Make sure the rope looped through the plank is even on both sides.

9) With the “UP” plank side facing the sky, tie the rope ends to the bottom of the bucket
handle on their respective sides.

10) Loop another piece of rope through the other end of the Plexiglas using the same method
as in step 5, and tie it around the tree (pole). The Plexiglas should be at a 45 — 60° angle
in comparison to the bottom of the bucket and lie 4 — 6 inches away from the
microphone.

11) With everything now tied, some adjustments will likely be necessary. Adjust the ropes
and pieces as needed for everything to line up correctly.

12) Record the GPS points of the location onto the datasheet using AnaPocket on the PDA.

13) Repeat steps 1 — 12 for each additional monitoring site.

4.2.2 Retrieving the Detectors the Following Morning

1) Untie both the bucket and plank.

2) Remove the detector from the bucket after it has been powered OFF.
3) Perform steps 1 and 2 for each additional monitoring site.

4) Return materials that are not kept in the office to where they belong.
5) Remove the batteries from the detector when finished monitoring.

4.3 Range Tunnel Temperature/Humidity Monitoring

4.3.1 Collecting Remote Unit Data

Currently, there are five tunnels containing three remote units each. Their locations are
displayed on the map in 65. The RTR-500DC’s downloading range is limited by the dirt and
concrete surrounding the remote units. Therefore, data from the remote units can only be
downloaded one at a time. Data from units located nearest the entrance of each tunnel can be
downloaded by standing at each respective tunnel entrance. Downloading data from the middle
units involves driving or walking along each tunnel until locating the pink reflective tape. This
tape marks the general area that allows for a successful download of the middle remote units.
Once the artificial bat roosts (Appendix X) are installed, a remote unit will be placed in each of
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them. The roost locations are displayed on the map in 57. Take the RTR-500DC and follow
these directions:

1) Upon arriving at a download point, use the side dial to scroll and select. Go to Gather
Data - Specify Remote Unit > Nol McCrady - Select the remote unit to download >
Execute. If the download is not successful, move as necessary to get closer to the
data.

2) Drive around to each location and download the data from all fifteen units.

3) Ifa unit continuously fails to download, there may be a problem with it, and this issue
should be further investigated.

Section 5 — Data Analysis

This section details how to download data from the CF cards and PDA onto the computer
network and how to save it properly. AnalookW for example will only work with files saved to
the desktop. Therefore, the network drive where all the data is saved must be mapped to the
desktop. Directions on how to map a network drive onto the desktop are provided in the first
part of this section. Basic instructions on analyzing recorded bat calls in AnalookW are also
included in this section along with converting and displaying the GPS points recorded in
AnaPocket. Directions on analyzing the data from the temperature/humidity data loggers are
given in the final part of this section.

5.1 Downloading and Saving Data

5.1.1 Mapping a Network Drive to the Computer Desktop

These steps only need to be performed if a mapped network drive does not already exist on
the desktop. Check this by seeing if any drives in Windows Explorer listed under “Computer”
are entitled “Conservation (\\mtc-envsrv4).”

1) In Windows Explorer, right click on Computer and select “Map network drive...”

2) Select a drive letter that is not already in use.

3) Type in the folder location as \\mtc-envsrv4\Conservation.

4) Make sure “Reconnect at logon” is checked.

5) Click Finish. The newly mapped drive should now appear in the Windows Explorer side

panel. It should also appear as a drive to download the CF card data onto in CFCread,
and open successfully in AnalookW.

5.1.2 Downloading Data from the CF Card

If Vehicle Monitoring:

1) Make sure the detector is turned off and remove the CF card.

2) Insert the CF card into its slot on the computer.

3) Open the log folder located within the CF card drive. Every file within this folder
entitled logX, where X is a number, provides time stamped details of previous monitoring
sessions. The newest file will be the highest numbered file until 1og99 is reached. At this
point, the oldest file will be overwritten. The newest log file will be the one that matches
the data being downloaded.

4) Ifuncertain about which file is the newest, open the syslog file within the log folder.

This gives the number of the next log file to be created or overwritten. The log file
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matching the newest data will be one number below this (unless it is cycling back to
log01 from 10g99).

5) Copy the log file that accompanies the monitoring session (typically one of the newest).

6) Navigate to this location on the network: \MTC-ENVSRVR4\Conservation\Fish and
Wildlife\129_Bat Population Monitoring\Data\Vehicle Monitoring)\.

7) Open either the East Start or West Start folder as appropriate for the data being
downloaded.

8) Open the Log Files folder and paste the log file at this location.

9) Replace the assigned number of the log file with the date the data was recorded.

10) Open the CFCread program.

11) Click “Choose Input File” and select the drive containing the CF card.

12) Select the DATA.DAT file and click Open.

13) Click Download and select appropriate download options. 59 provides detailed
information on the download options.

14) Select the mapped network drive as the place to save the files and navigate to Fish and
Wildlife > 129 Bat Population Monitoring - Data - Vehicle Monitoring - East Start
or West Start (depends upon starting location) - Bat File Originals.

15) Create a new folder and save the files in that location and include the date in the file
name (e.g. Batfiles 6 8 12). These files are not to be edited or changed. They serve
as a safeguard against a data analysis or editing accident. This is discussed in more detail
in on page 44.

16) Once the download process is complete, check the status.txt file to check for any errors.
Refer to page 81 of the User Manual for assistance on repairing CF card download errors.

17) If the data downloaded properly, the next step is to set the time parameters (if necessary).

18) Click Erase so the DATA.DAT file can be cleared and any time parameters will be set
onto the CF card.

19) Click Quit to exit the CFCread program.

20) Copy the files from step 2 and paste it to one of these paths once again depending upon
starting location. For West: \MTC-ENVSRVR4\Conservation\Fish and
Wildlife\129 Bat Population Monitoring\Data\Vehicle Monitoring\West Start\Bat File
Edits\. For East: \MTC-ENVSRVR4\Conservation\Fish and Wildlife\129 Bat
Population Monitoring\Data\Vehicle Monitoring\East Start\Bat File Edits\. The files
saved at these locations can be edited and changed for analysis.

If Overnight Monitoring:

1) Perform steps 1 — 5 under the “If Vehicle Monitoring” part of this section.

2) Navigate to this location on the network: \MTC-ENVSRVR4\Conservation\Fish and
Wildlife\129_Bat Population Monitoring\Data\Overnight Monitoring\.

3) Open the Log Files folder and paste the log file at this location.

4) Replace the assigned number of the log file with the date the data was recorded.

5) Perform steps 10 — 13 under the “If Vehicle Monitoring” part of this section.

6) Select the mapped network drive as the place to save the files and navigate to Fish and
Wildlife > 129 Bat Population Monitoring > Data - Overnight Monitoring - Site 1 —
Site 6 (depending upon the site the data is from) - Bat File Originals

7) Create a new folder and save the files in that location and include the date in the file
name (e.g. Batfiles 6 8 12). These files are not to be edited or changed. They serve
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5.1

as a safeguard against a data analysis or editing accident. This is discussed in more detail
in on page 44.

8) Copy the files from the previous step and navigate to this path: \MTC-
ENVSRVR4\Conservation\Fish and Wildlife\129 Bat Population
Monitoring\Data\Overnight Monitoring)\.

9) Open the folder that matches the site number of the data.

10) Open the “Bat File Edits” folder and paste the newly created folder of data into this
folder. The files saved at these locations can be edited and changed for analysis.

11) Repeat steps as necessary for each additional site.

.3 Downloading Data from the PDA (only necessary for vehicle monitoring)

1) Plug the PDA into the charging dock and plug the USB cord into the computer.

2) Once the PDA has connected itself, open Windows Mobile Device Center. If needing to
download Windows Mobile Device Center, go to http://www.microsoft.com/en-
us/download/details.aspx?id=14 and follow the download instructions. Installation can
only be performed when logged in as an administrator.

3) Go to Start > All Programs.

4) Click “Connect without setting up your device.”

5) Scroll over the File Management and click “Browse the contents of your device.”

6) Double click the PDA file and open the My Documents folder.

7) Select the mapped network drive as the place to save the files and navigate to Fish and
Wildlife - 129 Bat Population Monitoring - Data - Vehicle Monitoring - East Start
or West Start (depends upon starting location) - Bat File Originals.

8) Create a new folder and save the files in that location and include the date in the file
name (e.g. Batfiles 6 8 12). These files are not to be edited or changed. They serve
as a safeguard against a data analysis or editing accident. This is discussed in more detail
in on page 44.

9) Copy the files from step 2 and paste it to one of these paths once again depending upon
starting location. For West: \MTC-ENVSRVR4\Conservation\Fish and
Wildlife\129 Bat Population Monitoring\Data\Vehicle Monitoring\West Start\Bat File
Edits\.

For East: \MTC-ENVSRVR4\Conservation\Fish and Wildlife\129 Bat Population
Monitoring\Data\Vehicle Monitoring\East Start\Bat File Edits\. The files saved at these
locations can be edited and changed for analysis.

10) Completely close out of AnaPocket on the PDA by tapping the manila folder icon on the
PDA’s main screen.

11) Tap Running Programs, make sure AnaPocket is highlighted and select Stop.

12) Delete the files located on the PDA. Begin by going to Start - File Explorer.

13) Tap Menu - My Documents and open the Batfiles folder.

14) Tap the keyboard icon at the bottom of the screen to display it.

15) Tap Ctl > “a” to select all the files within the folder.

16) Tap Shift > Del to delete all the files within the folder. Tap “Yes” to confirm deleting
files. Do not worry about permanently losing any files for use on the PDA. They can
always be copied from the computer using Windows Mobile Device Center.

17) Disconnect the PDA from the computer.

18) Repeat steps 8 and 9 but this time under Running Programs just select to “Stop AIL”
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5.1.4 Downloading the GPS data from the PDA

When vehicle monitoring, all the GPS data is automatically downloaded with the other
files because the GPS data is embedded with the AnaPocket files recorded during each
monitoring session.

When overnight monitoring, a single GPS point should be taken of each location and
recorded on the datasheet and then transferred onto an Excel file.

5.1.5 Transferring Datasheet Information to an Excel File

If Vehicle Monitoring:

1)

2)

3)

Document everything recorded on the datasheet into the appropriate Excel file. For
West: \MTC-ENVSRVR4\Conservation\Fish and Wildlife\129 Bat Population
Monitoring\Data\Vehicle Monitoring\West Start\Data Collection Excel Tables\. For
East: \MTC-ENVSRVR4\Conservation\Fish and Wildlife\129_Bat Population
Monitoring\Data\Vehicle Monitoring\East Start\Data Collection Excel Tables\.

The file containing a blank datasheet is entitled “Data Collection Sheet Template.” Use
the completed datasheets located within the same folder for reference as needed.

Save the newly completed datasheet as a new file with the date of the data collection on
the end (e.g. Data Collection Sheet 6 8 12).

If Overnight Monitoring:

1)

2)
3)

Navigate to this path: \MTC-ENVSRVR4\Conservation\Fish and Wildlife\129 Bat
Population Monitoring\Data\Overnight Monitoring\Data Collection Excel Tables\.
Perform steps 2 and 3 under the “If Vehicle Monitoring” part of this section.

Repeat steps as necessary for each additional site.

5.1.6 Downloading Data from Temperature/Humidity Data Loggers

Instructions for downloading data from the RTR-500DC are included in 51.

5.2 Data Analysis Using AnalookW

5.2.1 AnalookW Setup

1)
2)
3)

4)

)

6)

Open AnalookW.

Click File > Open Anabat file and navigate to the mapped network drive.

Go to Fish and Wildlife > 129 Bat Population Monitoring - Data. From here open
either the Vehicle Monitoring or Overnight Monitoring depending upon which dataset is
desired. All bat call files should located somewhere within these two folders. Only use
files located within their respective Bat File Edits folders in AnalookW. This leaves
the original files untouched in case an irreversible mistake is ever made when analyzing
the bat call files.

Once the desired folder is located, open it to show all the files saved during that particular
day’s monitoring session.

Select any bat call file located within the opened folder. In AnalookW, when one file
from within a folder is opened, every bat call file within that folder is opened as well. It
is the selected file that will be first displayed however.

Set the horizontal resolution (x-axis) to F7 by clicking the F7 button located within the
magnification toolbar near the top of the screen. This changes how the seconds are
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7

8)

9)

displayed in conjunction with the bat files. F7 is only the recommended setting and the
setting of most reference calls, but it can be adjusted as needed for accurate analysis and
identification.

Tap the spacebar to toggle between compressed mode and true time mode. Compressed
mode is a condensed version of true time mode which displays the calls in real time. An
alternative method for toggling between modes is to select the button on the
magnification toolbar that looks like three curving lines or bat calls. When selected, the
bat files are in compressed mode. Typically compressed mode allows for easier analysis.

Toggle through the bat call files by using the bracket keys. r r
Bat calls will appear as distinct curved lines. Refer to
for examples. Bracket Keys

If needing to start over, press the Esc key to return the files to their original format.

Filters help remove excess noise that is recorded during the monitoring process from being
displayed as points in AnalookW. Several pre-set filters are built into the software and are easily
accessed. There are also filters saved on the network that can be loaded into AnalookW. The
final alternative is to create a new filter that can also be saved for later use. If ever becoming lost
or confused within the appearance of a file when experimenting with different filters, press the
Esc key to return the file to its original format.

Builtin Filters:

1)

2)

3)

Click Filter - Builtin and select a numbered filter. The higher the filter number, the
more points it will remove. The suggested number is 9, but it may be helpful to
experiment with other numbered filters to see what is best for the call being analyzed.
The selected filter can be switched off by pressing the “Page Down” key on the keyboard.
Pressing the “Page Up” key turns the filter back on.

Toggle between having a filter and no filter and closely analyze the bat calls. Make sure
that points representing bat calls were not accidentally removed by the filter. If such
points are being removed, select a lower numbered filter or follow the next steps to create
a new filter. Do the same if not enough excess points are being removed except select a
higher numbered filter.

Loading a Saved Filter:

1)
2)

3)

Click Filter > Load and navigate to the mapped network drive.

Once the mapped network drive is selected, go to Fish and Wildlife > 129 Bat
Population Monitoring - Supporting Documents & Software - Bat Call Reference
Library.

Select either Filter A or Filter B.

Creating a New Filter:

The process to create an effective new filter is difficult. Using one of the previously
covered filter methods is highly recommended. However, if wanting to experiment with
creating a new filter, refer to the Basic Use of Filters Manual for further explanation and
directions. It is located at this path: \MTC-ENVSRVR4\Conservation\Fish and
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Wildlife\129_Bat Population Monitoring\Supporting Documents & Software\AnaBat CD
& Manual\AnalookW\.

Identifying Bat Species with AnalookW Files

The following bats are expected to be commonly found and recorded during monitoring sessions:

Big Brown Bat (Eptesicus fuscus)

Eastern Red Bat (Lasiurus borealis)

Evening Bat (Nycticeius humeralis)

Tri-colored Bat (formerly Eastern Pipistrelle) (Perimyotis subflavus)
Brazilian Free-tailed Bat (Tadarida brasiliensis)

Rafinesque’s Big-eared Bat (Corynorhinus rafinesquii)

Seminole Bat (Lasiurus seminolus)

The following bats may exist at McCrady Training Center. They may be recorded during
monitoring sessions on rare 0ccasions:

Southeastern Myotis (Myotis austroriparius)
Silver-haired Bat (Lasionycteris noctivagans)
Hoary Bat (Lasiurus cinereus)

The steps below provide directions for identifying bat calls illustrated in AnalookW.

1)

2)

3)

Only attempt to identify calls with a minimum of 5 pulses (lines). Attempting to identify
calls with fewer pulses than this can easily lead to misidentifying the call. If a file is
clearly a bat call but has fewer than 5 pulses, label it Unknown.

Navigate to the species reference call library at this location \MTC-
ENVSRVR4\Conservation\Fish and Wildlife\129 Bat Population Monitoring\Supporting
Documents & Software\Ball Call Reference Library\.

Compare these reference calls to the recorded calls in AnalookW and attempt to identify
the species of the recorded calls. The following bat calls are included in the library and
can also be found in 61 listed as Figures 7 — 14 respectively:

EPFU — Big Brown Bat (Eptesicus fuscus)

LABO — Eastern Red Bat (Lasiurus borealis)

NYHU - Evening Bat (Nycticeius humeralis)

PESU — Tri-colored Bat (formerly Eastern Pipistrelle) (Perimyotis subflavus)

TABR - Brazilian Free-tailed Bat (Tadarida brasiliensis)

CORA — Rafinesque’s Big-eared Bat (Corynorhinus rafinesquii)

LANO - Silver-haired Bat (Lasionycteris noctivagans)

LACI - Hoary Bat (Lasiurus cinereus)

UNK — Unknown bat species

Q — A bat call or other recorded sound of question or interest

Some additional tips for identifying pulses include:

Also included in Appendix VII are example recordings of insect noise and road noise.
They are Figures 15 and 16 respectively. Files such as these should be deleted. File
deletion is covered in on page 48.

Eastern red bats will typically have pulses with a minimum frequency of 35 — 40 kHz.
When displayed, the call will curve slightly down towards this minimum frequency
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1)
2)

3)
4)

5)

6)

7

8)

9)

where it will have a minor bunching appearance. The minimum frequency also tends to
vary slightly from one call to the next.

Tri-colored bats have a call very similar to the eastern red bat. A key difference to look
for is the minimum frequency is more consistent and more likely to be in the 40 — 45 kHz
range. It does not vary significantly from one call to the next. Additionally, the pulses
displayed are typically shorter in length than those produced by the eastern red bat.
Evening bats produce a call that has a minimum frequency of always right around 35
kHz. Their calls create pulses that look very similar to the tri-colored bat. The key
difference is that the evening bat consistently has a lower minimum frequency when
compared to a tri-colored bat call

Big brown bats produce a call with a minimum frequency that is consistently around 25
kHz. The curve to the displayed pulses is also very consistent in how it sweeps down
towards the minimum frequency.

Brazilian free-tailed bats also produce a call with a minimum frequency that is
consistently around 25 kHz. Beyond the minimum frequency, Brazilian free-tailed bat
calls can display a wide variation in appearance from one call to the next.

Open AnalookW if it is not already open and click Load on the toolbar near the top of the
screen.

Select the mapped network drive and click Fish and Wildlife - 129 Bat Population
Monitoring - Data - AnaBat Individual Species.

Open the AnalookW Species List file.

The abbreviations given in the list from step 3 in Section 5.2.3 should now be displayed
in the labeling boxes near the top of the screen.

If wanting to add another label, right click an empty box and give it a name. Click Save
As to save the new list. To get a blank list, click one of the empty boxes to the right of
“Bufl+, Buf2+, etc.” and begin entering new label names. Remember to perform a Save
As to keep this new list.

To label a bat call, simply click the species labeling box that matches the species in the
displayed call. The call should now be labeled in the Species box in the bottom left
corner of the screen.

To add more information within any of the other labeling fields at the bottom of the
screen for an individual file, simply click anywhere in the gray area at the bottom. Fields
where information can be entered will turn white. These fields are collectively known as
the Global Header Change.

Type in the needed information and hit Enter. Clicking outside of the gray area without
pressing Enter will cause the newly typed information to be deleted.

Once all the labeling is finished, one way to obtain a species count is to go to Tools >
Count Labels.

10) Click Change next to “Start from Folder:” and follow the same path as given in step 2.
11) Set the Number of folder fields to 1, the Output Format to File, Time as By night, and

Dummy Lines to None.

12) Click Run. Name the file “Species Count” followed by the date of the files.
13) Navigate to the Species Files folder in Windows Explorer by following the same path as

given in step 2. The newly created file will be a .txt file within the Species Files folder.
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14) The settings listed in step 11 are only suggestions. To learn more about the various

1)

2)

3)

4)

5)

1)
2)

3)
4)

6)
7
8)

9

1)

settings of the count labels tool navigate to this path: \MTC-
ENVSRVR4\Conservation\Fish and Wildlife\129 Bat Population Monitoring\Supporting
Documents & Software\AnaBat CD & Manual\AnalookW\. The document is entitled
“The count labels tool.”

Marking files provides many ways to keep files organized by copying, moving, deletion,
or manipulation. When a file is marked, it is essentially being selected. First, to access
the different marking options go to File > Marking.

This opens a dropdown menu of several options including mark, unmark, mark all,
unmark all, and reverse all. Another option under the File menu is to “Mark if labelled.”
A file is considered to be labeled when any information is found in the Species field.
Mark files as desired for organizing.

Once files are marked, click Edit and select from the options of copy, move, or delete.
The selection process here all depends upon what is being done with the data.

A fourth option under the Edit menu for marked files is Global Header Change.
Selecting it will open a new window entitled “Alter fields for global header change.” It
contains all the same fields as the Global Header Change box at the bottom of the screen.
The only difference here is that when any information is added to the “Alter fields...”
box, it is applied to every marked file.

To delete information within the Global Header Change box from all marked files, type a
tilde (~) into the fields wanting to be cleared of information.

At this point, all files containing bat calls should be labeled with either a specific species
or an unknown if they are to be kept.

Click File > Mark if labelled.

Click File > Marking - Reverse All. Now all the unlabeled files should be marked.
Click Edit - Delete if marked. Now only the labeled files should remain.

Next is to disperse the files into their appropriate species specific folders. Go to File >
Disperse.

Under the “To” section, click Other.

Navigate to the mapped network drive and click Fish and Wildlife > 129 Bat Population
Monitoring - Data - AnaBat Individual Species.

Under “Action,” select Copy. Do not select Move because that will remove the files
from their original location.

Click Run. AnalookW will disperse each bat call file into a folder that matches its label.
For example, a file labeled EPFU will be copied into a folder with the same name within
the Species Files folder. “N Folders” and “N Files” show the number of new folders that
were created and new files copied. Files with multiple labels will be dispersed into every
folder for which they have a label. Finally, if a folder does not exist yet for a specific
species label, AnalookW will automatically create one during the dispersing process.

Open AnalookW and click File > Open Anabat file.
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D
)

2)
3)
4)
5)

7

1)
2)
3)

4)
5)

6)

7)
8)

9

Select the mapped network drive on the desktop containing the bat files and navigate to
the bat files folder that corresponds with the desired GPS data and open it.

With the corresponding bat files now open in AnalookW, click Tools - Converter >
GPS: PDA to Excel.

In the new window, click Source and navigate to the GPS.abg file that matches the
previously opened bat files.

Make sure the time zone is set to -4.

Click Run. Once the status states “Operation successful” click Quit.

This process creates a spreadsheet of all the GPS data that is saved within the folder of
the open bat files and is entitled GPS_EXCEL. Select this file and add the date it was
taken to the file name. Even files that have been deleted in AnalookW will be
included on this spreadsheet.

.8 Converting and Displaying GPS in Google Earth (Vehicle Monitoring Only)

Make sure all unwanted AnalookW files have been deleted.

Open AnalookW and click File = Open.

Select the mapped network drive on the desktop containing the bat files and navigate to
the bat files folder that corresponds with the desired GPS data and open it.

Select File > Make GPS File.

Make sure that the file is being saved to its desired location on the network, the output
file type is GPX, and the time zone is set to -4. The location to save the data, depending
upon starting location, would be either: For West: \MTC-
ENVSRVR4\Conservation\Fish and Wildlife\129 Bat Population
Monitoring\Data\Vehicle Monitoring\West Start\GPS Map Files\.

For East: \MTC-ENVSRVR4\Conservation\Fish and Wildlife\129 Bat Population
Monitoring\Data\Vehicle Monitoring\East Start\GPS Map Files\.

Click Run. The box at the bottom will display how many trackpoints were found. Once
that is done calculating, click Close.

Open Google Earth.

Click File & Open. Change the file type to “Gps (*.gpx*.loc*.mps*.gdb...)” and
navigate to the newly created GPX file. The default file name will be GPSfolder.gpx.
If a GIS Data Import window appears, click OK and navigate to the GPS points as
needed.

10) If desired, save the Google Earth image in the same folder the data was saved in from

1)
2)

step 5.

.9 Converting and Displaying GPS in ArcMap (Vehicle Monitoring Only)

Perform steps 1 — 6 from Section 5.2.8 if needed for the selected file.
Open GPSBabel. If needing to download GPSBabel, go to www.gpsbabel.org and follow
the download instructions. Installation can only be performed when logged in as an
administrator.

Under Input, select GPX XML as the file format.

Click on File Name(s) and add the GPX file that was created in AnalookW.

Make sure Waypoints, Routes, and Tracks are all checked.

Under Output, select Google Earth (Keyhole) Markup Language as the file format.
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7) Click on File Name, create a file name that includes the date
(e.g. GPS_Conservion 6 26 12), and save it in one of the following folders depending
upon the starting location: For West: \MTC-ENVSRVR4\Conservation\Fish and
Wildlife\129_Bat Population Monitoring\Data\Vehicle Monitoring\West Start\GPS Map
Files\.

For East: \MTC-ENVSRVR4\Conservation\Fish and Wildlife\129 Bat Population
Monitoring\Data\Vehicle Monitoring\East Start\GPS Map Files\.

8) Click Apply. The data has now been converted into a KML file to be used in ArcMap.

9) Open ArcMap and then open the “Anabat Driving Route & Overnight Locations”
ArcMap Document. It is located at this path: \MTC-ENVSRVR4\Conservation\Fish and
Wildlife\129_Bat Population Monitoring\Maps\.

10) Open ArcToolbox and select Conversion Tools 2 From KML - KML To Layer.

11) In the new window, the Input KML File is the file created in step 8.

12) For Output Location, connect to MTC-ENVSVR4 on the network if necessary.

13) Navigate to GPS Map Files folder for either East Start or West by clicking Conservation
- Fish and Wildlife > 129 Bat Population Monitoring - Data - Vehicle Monitoring
- East Start or West Start.

14) Highlight (do not open) the GPS Map Files folder and click Add.

15) Under “Output Data Name” type the name as GPS_Bat Calls followed by the date.

16) Click OK. It will take ArcMap a moment to run the operation. The layer will
automatically be added to the map file.

17) The points will be labeled making the map overly crowded. To fix this right click on the
data frame in the Table of Contents. It is called “Bat Data Collection” in the Anabat
Driving Route & Overnight Locations map.

18) Scroll over Labeling and select Label Manager...

19) In the Label Manager window, uncheck the box next to GPS device: Points under Label
Classes. Click OK.

20) The symbol representing the GPS points can also be changed by clicking it under the
Table of Contents.

21) To create a shapefile from this layer, right click “Points” and select Export Data.

22) Click the manila folder to assign the file a name and save location. To stay consistent,
name the file GPS Bat Calls followed by the date and save it in the same location as the
files in the previous steps.

5.2.10 Converting and Exporting AnalookW Files

1) Before beginning this section, it is highly recommended that the AnalookW files to be
exported be filtered and labeled. See Sections 5.2.4 —5.2.6 if needed.

2) Open AnalookW and go to Tools - AnaHead.

3) Navigate to the necessary folder on the left side of the screen.

4) Once the desired folder is open, all the AnalookW files within it should appear in the
column next to the folders. Highlight all files to be exported into a .txt file.

5) Go to File > Download. This will create a .txt file of the selected data. The .txt file
itself will automatically be located in the same location as the exported files and be
assigned the default name of “header.”

6) Locate the “header” file through Windows Explorer and change the name to Bat Calls
followed by the date the calls were recorded.
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7)
8)
9)

Open a new Excel spreadsheet and select the Data tab.
Click “From Text” and navigate to the desired text file. Click Import.
In the new window, select Delimited and click Next.

10) Check Tab as the delimiter and click Next.
11) Click Finish and decide whether to import it into the current worksheet or a new

worksheet as deemed appropriate.

12) Cleanup any rows or columns as needed to have only the necessary data.
13) Save this file in the same location as the .txt file and give it an identical name.

1)
2)
3)

4)

5)

In AnalookW, open the desired AnalookW sonogram file.

Go to Start > All Programs > Accessories = Snipping Tool.

Once the Snipping Tool is open, drag the cursor across the screen encompassing the
entire sonogram.

Click the Save icon and navigate to the appropriate Sonograms folder. Each overnight
data collection site has its own folder, and a Sonograms folder exists for both east and
west vehicle monitoring. For example, if saving a sonogram that was recorded overnight
at Site 1, go to Fish and Wildlife > 129 Bat Population Monitoring - Data - Overnight
Monitoring - Site 1 - Sonograms.

Save the snip as a .jpeg and make the file name the same as the file time given for the
sonogram in AnalookW. This information appears in the bottom left corner of
AnalookW. Additionally, include the bat species if possible (e.g.
20120608 2042 42 EPFU).

5.3 Data Analysis of Temperature/Humidity Data Loggers

1)

2)
3)
4)

5)
6)

In the Main Menu of the RTR-500DC, scroll down to Data List and select it by pressing
in on the dial.

Scroll to highlight the desired remote unit and press in on the dial to select.

Scroll and highlight Display Graph. Select it by once again pressing the dial.

There are two graphs that can be displayed. The temperature graph is channel 1 and the
humidity graph channel 2. Toggle between the two channels by pressing and holding in
the dial. The channel being displaying will be highlighted in the top left corner of the
screen.

Use the dial to move along the graph and display each recording.

To display a different remote unit, press the dial and continue to select Back until
reaching the desired screen.

Connect the RTR-500DC to the computer using the gray USB cord.

Open the RTR-500DC Manager program.

If the data list does not automatically generate, click Communication - Collect Data
Info.

Highlight the data you want to download. If wanting to download all the data, press
Ctrl+a to select all.
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5)
6)

7

8)
9)

Right click and select Download Data...

When a new window appears, click Start. The program will then download all the
selected data.

A limitation of this program is that it automatically saves the data on the C: drive under
Users = Your user name - My Documents = TandD Corp - RTR-500 for Windows >
data.

Inside the “data” folder is where the downloaded files are found.

Cut this data and go to the TRX Files folder located at this path: \MTC-
ENVSRVR4\Conservation\Fish and Wildlife\129 Bat Population Monitoring\Data\RTR
Collected Data\.

10) Create a new folder with the collection date as the name and paste the downloaded data

into the newly created folder.

5.3.3 Creating, Analyzing, and Saving Data Graphs

1)
2)
3)
4)
)
6)
7

8)

9

In order to view data on a graph, it must first be downloaded by following the directions
in Section 5.3.2.

In the RTR-500DC Manager program, click Graph > Open Temp/Humidity Graph or
Open Multi-scale Graph.

Once the selected graph window appears, click File - Open and navigate to the saved
data files.

Highlight the desired file and click Open.

In the graphs, Chl is temperature and Ch2 is relative humidity. These can be turned on
or off by clicking the corresponding blue numbers on the toolbar.

Additional remote until graphs can be added by going to File > Open, selecting a
different remote unit, and clicking Add. The newly added data will be assigned the next
two available channels but still represents temperature and relative humidity respectively.
When analyzing the graphs, look for any gaps of anomalies within the data. Either of
these situations could mean a malfunctioning remote unit and should be further
investigated.

These graphs can only be saved as .trx files which are not widely compatible. If needing
to save and share a graph, the best alternative is to use the Snipping Tool. It is found in
the Accessories folder under the Start menu.

Once open, click and drag across the area needing to be captured. Save it as either a PNG
or JPEG file in the Graphs folder. Use the path link provided in step 8. Include the type
of graph it is and the date in the file name.

5.3.4 Importing Graph Data into Excel

1)
2)
3)
4)

5)
6)

Complete steps 1 — 4 from the previous section.

Click File > Save Data in Text File...

Make the delimiter “Comma” and set the “Range to be saved” as “All data.”

Navigate to \MTC-ENVSRVR4\Conservation\Fish and Wildlife\129 Bat Population
Monitoring\Data\RTR Collected Data\Text Files\. Create a new folder with the
collection date as the name and include the remote unit name and date in the file name.
Click Save.

Open Excel and select the Data tab.

Click “From Text” and navigate to the desired text file. Click Import.
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7) In the new window, select Delimited and click Next.

8) Check Comma as the delimiter and click Next.

9) Click Finish and decide whether to import it into the current worksheet or a new
worksheet as deemed appropriate.

10) Cleanup any rows or columns as needed to have only the necessary data.

11) From here, additional graphs can be made using the data in Excel and are much more
user-friendly than the original graph’s .trx files.

12) Navigate to this path to save the Excel spreadsheet: \MTC-
ENVSRVR4\Conservation\Fish and Wildlife\129 Bat Population Monitoring\Data\RTR
Collected Data\Excel Files\. Create a new folder with the collection date as the name.

13) Include the remote unit name and date in the file name (e.g. B9 3 6 13).

14) Repeat each step from this section as needed for each remote unit’s data.

5.4 Data Analysis Using EchoClass Automated ID Software

Automated bat identification software is improving, but it is still not reliable or accurate enough
to be used in any serious analysis. An example of this is EchoClass. It is an open source bat ID
software developed by Dr. Eric Britzke for the U.S Fish & Wildlife Service. Version updates of
the software can be found here:
http://www.fws.gov/midwest/Endangered/mammals/inba/inbasummersurveyguidance.html.
Check this website every couple months to determine when and if improvements to the software
are being made. Currently, Echoclass is nothing more than an interesting tool for immediate, but
unreliable, bat call identification. If interested in experimenting with the software, download and
install it by clicking the above link. There is also an instruction manual for download which will
presumably be updated with each software update. The instruction manual is vital because it
outlines the specific way the data folders must be named and structured for the program to work.

Section 6 — Basic Operation Summary

This section outlines the basic steps that need to be executed to effectively use the Anabat SD2
detector. It is designed to serve as a quick reference guide.

1.1 Eight Simple Steps to Monitoring

1) Provide power to the detector
4 x AA batteries or external +12V battery.

2) Insert initialized CF card
Use the CFCread program to initialize the CF card. It is important that no timing parameters
are set at this stage. See on page 24 entitled Initialize CF Cards if the initializing process has
yet to be completed.

3) Press POWER button
When the detector is ready the RECORD and STATUS LEDs will be lit. The time taken for
the detector to boot up will vary with the CF card size and the amount of existing data stored
on the card.

4) Select required division ratios (DATA DIV and AUDIO DIV)
See on page 27 about setting the division ratios for details.
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)

6)

7)

8)

Adjust volume

Press the UP or DOWN arrow buttons.

Adjust sensitivity

Setting the sensitivity at 7 is typically the standard but can be adjusted accordingly. Ideally,
the detector should only be making a sound when a bat is detected.

On completion of recording session

Press the POWER button. It is now safe to remove the CF card.

Download and view data

Use the CFCread program to download the saved data from the CF card onto your computer.
Then use the AnalookW program to view, analyze, and identify the bat calls to species. See
on page 41 on downloading data from the CF card for details and on page 44 for instructions
on using AnalookW.
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Appendix I — Anabat SD2 Detector Reference Diagrams
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Figure 1. Anabat SD2
detector Front Panel Buttons
and Functions.

Figure 3. Anabat SD2 detector
Rear Panel with CF card access.
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Figure 2. Anabat SD2 detector Side Panel Connectors.
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Appendix II — Monitoring Checklists

Vehicle Monitoring Items Checklist

I O T B B B

N Y Y I O o O

Anabat SD2 Bat Detector

Roof Mount

Route Map

2 CF Cards (if not using PDA)

PDA and CF Card (important to have CF card at all times in the event of PDA
malfunction)

PDA Bracket

GPS Attachment to PDA

Datasheet

Pen

Extra AA Batteries

Flashlight and Headlamps

Orange Vests

Communications Radio

Small Flathead Screwdriver for USB Cable

Overnight Monitoring Items Checklist

(|

N Y e e O A B

Anabat SD2 Bat Detector for Each Site Being Monitored (max of 3)
Bucket with Lid for Each Detector (bucket should have hole in bottom)
Sponges

Reflector Plank for Each Detector

Rope (use pre-cut pieces first)

Knife or Scissors to Cut Rope (if necessary)

Map of Monitoring Sites

One CF Card for Each Detector Being Used

PDA with GPS Card Attached

Datasheet (see Appendix III)

Pen

Flashlight and Headlamps (depending on time of day placing/retrieving detectors)
Orange Vests

Communications Radio

DO NOT DISTURB sign and tape if needed

Zip Ties (only for hanging on tunnel gate)
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Appendix III — Acoustic Monitoring Datasheet

Investigator(s): Date:

Monitoring Type: [0 Vehicle O Overnight Monitoring Number*:

Anabat Number(s) & Site Located:

Start Lat/Long: N / E /
End Lat/Long#: N E
Wind Cloud Moon Moon
Time Temp (F) Humidity Speed Cover Visible? Phase %

Start
Survey:
End
Survey:

Comments (ex. high insect noise, poor road conditions, break in sampling, etc.):

*Number should follow in sequence from the last monitoring session. If vehicle monitoring, the number should
include “V” for vehicle monitoring and an “E” for east or “W” for west to denote starting point (ex. 2VE). If
overnight monitoring, the number should include “N” for overnight monitoring (ex. 2N). Include in parentheses,
next to its respective ANABAT number, the site number where each detector is located.

#Does not need to be completed if overnight monitoring.
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Appendix IV — Monitoring Map
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Appendix V — Download Options for CF Card

A. Split nights: Tick box to save separate nights of
data as separate folders.

B. Division Ratio: The Data Division Ratio used
during the monitoring session is automatically stored
in the DATA.DAT file by the SD2 and noted in the
status.txt file meaning that editing this option is now
unnecessary and useless.

C. Wayv, GPS etc: Tick “Generate” to download
Wayv, GPS etc files. These will only appear if a GPS
was connected to the SD2.

D. Status: IMPORTANT! Tick “Generate” to
produce a status.txt file. This will display errors or
changes that occur during the download process.

E. Anabat files: Tick “Generate” to download your
AnaBat sequence files.

F. Save on Cal: Tick box if bat calls were manually
saved by pressing the SAVE button on the detector.
Separate AnaBat sequence files will be produced for each call saved.

G. AutoSave parameters: Tick “Use” to retain the default settings shown. This section allows
the Max TBC (secs), Min Line Length, and Smooth parameters for interpretation of the bat call
data (what is and is not recognized as a bat call) to be adjusted. The default settings are
appropriate for most bat call data and are recommended if what these parameters will do to the
data is not understood. For further details refer to page 79 of the User Manual.

H. ZCA files: Tick “Generate” to download ZCA files. These files contain a whole night of data
in one AnaBat file which can be viewed in AnalookW. Raw is recommended for the SD2.
Selecting Raw leaves the time data recorded as is.

Raw data file: The original raw data (not to be confused with the raw ZCA files) is
automatically downloaded from the DATA.DAT file by CFCread when the data is downloaded.
The raw data file will be named after the serial number of the unit used to record the data and the
date (serial & date). It will NOT be named DATA.DAT. The raw data file can be used to
backup the data and/or re-download the data (useful if wanting to use different AutoSave
parameters).
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Appendix VI — Overnight Monitoring Protection Reference Pictures

Figure 5. Front view of detector protection setup.
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Figure 16. An example of insect noise recorded by the detector.
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Appendix VIII - RTR-500DC & RTR-503 Reference Diagrams

Figure 17. Diagram listing the parts of the RTR-500DC.

Figure 18. Diagram listing the parts of the RTR-500
remote unit models. The RTR-503 model is on the right.
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Appendix IX — Map of Range Tunnel Locations
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Appendix X — Artificial Bat Roost

> P o -

Figure 20. Artificial bat roost and surrounding habitat.
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